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 Introduction 
 
Method of 3D modelling 

 
The method for the 3D modelling of TEM (Transient Electromagnetic) processes is based on 

the theory and algorithm developed by Druskin and Knizhnerman [1988]. 
The 3D problem is solved using quasi-stationary approximation; this approximation is 

possible when the displacement currents are negligibly smaller than the conduction current. 
It is valid given the condition 

 
                                          σE >> ∂D/∂t,                                          (1) 
 

where D and E are the vectors of the electric induction, and σ  is the conductivity of the 
medium.   
In this approximation, Maxwell’s equations take the form 

 
                                      curl H - σE = jext                                         (2.1) 
                                       curl E + µ∂H/∂t = 0.                      (2.2) 
 

Here, Е=(Ex,Ey,Ez) and H=(Hx,Hy,Hz) are the vectors of the electric and magnetic fields, 
jext[A/m2] is the extraneous current density, µ is the magnetic permeability of the medium, µ=µrµ0, 
µ0=4π10-7[H/m], µr is the relative magnet ic permeability,  and σ is a scalar function of the 
coordinates σ(x,y,z).  

 Equations (2.1) and (2.2) can be transformed into an equation with respect to the electric 
field vector E:  
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In the TEM-FAST system, the current I is switched off at time t=0, and the function jext can 

be presented as 
 
                                            jст=-φ0(x,y,z)*h(t),                              (4)  
                                           h(t)=1 at t<0, and 
                                          h(t)=0 at t≥0 . 
 

Thus, the electric field E for times t≥0 can be determined from the solution of the Cauchy 
problem: 

 
                         E|t=0=φ0,         E→0 at |x|, |y|, z→∞.                    (5) 
 

Because the electric and magnetic fields in a conductive medium decrease with distance 
from the source (because of geometrical dissipation and the absorption of the field), far enough 
from the source it is always possible to restrict the workspace by a prism,  

 
                                   0≤ z≤Zmax |x| ≤Xmax and |y|≤Ymax,             (6) 

 
and replace the boundary conditions (5) with (6), which is equivalent to the situation where the 
work prism is surrounded by a medium with an infinitely large conductivity σ→∞. On the 
earth’s surface, z=0, the normal component of the field Ez is equal to zero because the 
conductivity of air is extremely small: σ→0. 
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The entire domain 0≤z≤Zmax, |x|≤Xmax and |y|≤Ymax is divided into rectangular cells according 
to the scheme: 

                                       -Xmax≤x1<x2…..xn≤+Xmax                                        
                                       -Ymax≤y1<y2…..ym≤+Ymax 
                                          0≤ z1<z2….. zk≤Zmax 
 
 

               (the working grid size is n×m×k, where n≤200, m≤200, and k≤200). 
 

No restrictions are placed on the grid (for instance, dxi=xi+1-xi) by the provided algorithm, 
i.e., the grid can be irregular, for example, logarithmic. All the field’s derivatives E=(Ex,Ey,Ez) 
along the spatial coordinates x, y, and z are replaced by their discrete analogues inside each cell. 

An application of the well-known finite difference technique can then be used to reduce the 
system of integro-differential equations to a system of finite difference equations that can be 
solved by the Galerkin method on the Krylov subspace. The solution is expressed in terms of the 
eigenpairs of the matrix determined using a simple Lanczos process. 

The 3D models of the medium are created on the basis of a model grid that is built as 
 

                                       -Xmax≤ x1<x2…..xN ≤+Xmax                                        
                                       -Ymax ≤ y1<y2…..yM ≤+Ymax 
                                             0≤ z1<z2….. zK ≤Zmax. 
 

Despite the fact that the algorithm admits the use of an irregular grid, for the convenience of 
design (drawing), the model grid in the interface is made regular with fixed steps dx, dy and dz. 
The number of nodes in the grid (N×M×K) weakly influences the calculation time because prior 
to the calculations the mode is automatically simplified; cells with identical resistivities are 
joined and form an irregular rectangular grid. 

Models constructed from experimental data with ten resistivity levels can contain up to 
2,000-3,000 cells. However, in complicated geoelectric situations and for large profile lengths, 
the number of cells can be as large as 100,000-300,000, which somewhat slows the calculations. 

The work and model grids do not spatially coincide, which creates a problem when 
determining the effective conductivity in a work cell. The algorithm uses a special method to 
calculate the conductivity along the orthogonal x, y and z directions; in fact the conductivity inside 
each cell is different in the x, y and z directions (macro anisotropic effect): σ=(σx,σy,σz). 

Because the calculations of 3D models are constructed using experimental sounding data, the 
problem of an appropriate approximation for the earth surface relief arises. Because the model 
and work grid are rectangular, it is necessary to essentially decrease the steps (dx, dy and dz) to 
provide a convenient approximation of the real relief; in addition, we must use high resistivity  
“air” with a conductivity σ~10-4 Ohm-m-1. The size of the work grid is thereby sharply increased, 
(n×m×k) ~ 100,000-200,000 cells, and the calculation time increases. 

The picture shows the position of a transmitter-receiver loop (antenna) located on the 

surface of a slope (А) and the location of the loop in the grid model (B). 

 
 
 
 
 
 
 
               А                                                                          В 

 

Unfortunately, the algorithm does not permit “A” to be modelled because of accepted 
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limitations on the locations of the receivers and field sources on the insides of grid cells. 
 

Program installation 
 
 

The program was developed for Windows XP/7/8 x32/64 and is delivered as an executable 
module (TEM-3D-WIZARD.exe), libraries and drivers. An electronic USB-key is used to 
protect the user from virus attacks and the unauthorized distribution of the program. The 
program code is based on OpenMP (Open Multi-Processing) technology and is designed for 
multi-threaded parallel computing systems with shared memory. 

 
Delivery Set: 

 
1.  TEM_3D_WIZARD.exe - the main executable file; 
2.  Three dynamic libraries: 

                           LIBIFCOREMD.dll 
                           LIBMMD.dll 
                           NOVEX32.dll 

3. The directory DRIVERS with the protection «GUARDANT» drivers; 
 4. The USB «GUARDANT» key (dongle); its serial number (s/n) is written in the 
warrantee and in the About window of the main menu (for example, 2C48-0000). 

 
                                        
 
 
         
 
 
                               

5. The standard Windows libraries 
 

MSVCR80.dll 
MFC80.dll 
KERNEL32.dll 
USER32.dll 
GDI32.dll 
 

 must be located in the directory ..\WINDOWS\SYSTEM32\ 
  

The installation of the program consists of opening a new directory (for example, 3D- TEM) 

and coping of all the available components (4 files and Drivers section) to that directory. 

After connecting the key and installing the drivers (run DRIVERS\instdrv.exe), the program 

is ready for operation. When the «GUARDANT» driver is correctly installed, the indicator on 

the USB key glows. The program is ready to start. 

 
ATTENTION! 

Each USB key has its own unique number. In case of loss, a replacement cannot be 
produced. If the key is damaged (mechanically or electrically), the producer can replace the 
program’s key with another key. The replacement conditions can be found in the guarantee 
document. 
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 Part 1. The interface for constructing a medium’s model  
 
Main window menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Fig. 1.1. The TEM 3D WIZARD main window. The work map is the XY plane 
 

The Grid Range, m, is the table for setting the grid’s parameters to create the medium’s 
model. 

Here, the left column (Dx, Dy, Dz) of the table is the size of the steps along the X, Y, and Z 
grid directions, and (Xmax, Ymax, Zmax) on the right side of the table is the size of the map (the 
size is in meters). The limitations of the parameters are 

 
Nx=X_max/Dx - even number, Nx≤300, 
Ny=Y_max/Dy - even number, Ny≤100, and 
Nz=Z_max/Dz - integer number, Nz≤300. 

 
If the specified Nx, Ny or Nz do not correspond to the stated criteria, the program corrects 

either the grid size X_max, Y_max or Z_max or modifies Dx, Dy, or Dz. 
Ohm-m - the colour scale of the resistivity.  
 
A single click on a coloured square box activates that colour; activation is indicated by a 

marker on the left side of the square. The lowest square box in the sky-blue colour is used for the 
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air resistivity; it is applied when modelling a surface relief. We do not recommend changing the 
colour or resistivity (10000 Ohm-m) of this box. 

Double clicking the square box opens a standard colour dialogue, which allows the colour of 
any box to be changed. 

Double clicking on the <Ohm-m> heading sets the max/min scale resistivities. 
Depth Layer – set the number and upper and lower boundaries of the layer, i.e., the layer 

shown in the XY map at the moment 
X=979 m Y=-697 m – the coordinates of the cursor position on the XY map 
X-Z Section – the switch for opening the section along the X-axis 
Y-Z Section – the switch for opening the section along the Y-axis  

 The triangle markers on the left hand side of the XY map indicate the locations of the X-Z 
and Y-Z sections. The markers can be moved either using the mouse (keeping the left button 
pressed) or with the arrows (→) (←) (↓) (↑) on the keyboard. The Page Down and Page Up 
keys change the position of the XY plane along the Z-axis (change of depth). 

 

 
      

Open Model - load a model created earlier and saved to file *.3Dm 
Save Model - load the current model to a file *.3Dm 
Input SetUp - load the parameters of the grid created earlier and saved in file *.stp 
Save SetUp - save the current parameters of the grid in a file *.stp 

 

 
     

Undo-Redo - restore the design one step back or ahead 
Copy - copy the current design 
Paste - insert the copied design in the specified position 
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Clear All – clear the entire XYZ block 
Prism - insert a prism 
Cone - insert a cone 
Layers - insert a layered model 
Modelling - open the window for field calculations in the created model of the medium  
Help - help and information  
About - program serial number 

 
 Drawing a model on the XY map 
 

1. Set the layer for drawing (Depth Layer). 
2. Single click the cell to set the cell colour according to the current palette 
3. “press→move→release” with the left mouse button to draw a line. All the cells 

intersected by the straight line connecting the first and last points are painted over. 
 4. Continuously pressing the Shift button with “press→move→release”, use the left mouse 

button to paint the cells inside the drawn rectangle. 
 5. Clicking the right mouse button on the map allows the last drawn object (line, cell or 

rectangle) to be copied to the underlying layers. 
 Example: To paint over the entire map with any colour (draw a rectangle), press the right 

mouse button, and you will see the window: 
 

 
 

Press the OK box, and the whole model up to h≤1000 m depth is filled by the selected 
colour, i.e., a uniform half-space is created. 

 
XZ and YZ Sections 

 
 1D is the mode for drawing horizontal layers. Clicking on any cell creates a horizontal layer 

filled with the current colour. When you hold down the Ctrl button, the horizontal layer flows 
around the cell that was previously filled with any colour - Fig. 1.2. 

 2D is the mode for drawing quasi two-dimensional structures. Like drawing on the 
horizontal XY map, it is possible to draw a plane figure on the XZ or YZ maps. When the mouse 
key is released, the distance along the Y-axis that should reach the figure is requested (Y 
Length (m)) - Fig. 1.3. 

 3D is the mode for drawing 3D structures; only “plane” cells lying on the XZ or YZ maps 
are painted. As in the 2D mode, lines and rectangles can be drawn. 

 2-d Screen – Open a window with an additional screen. 
 

All the possible functions are defined in Help. 
In particular: 
Insert - key to insert the selected layer (active) of resistivity ρ (here ρ=31 Ohm-m) at a depth 
corresponding to the position indicator of the depth (here h=175 m); 
Delete - key to remove a layer at a depth corresponding to the position indicator of the depth 
(here h=175 m). 
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 Fig. 1.2. The XZ section (Y=-0-50 m) of a 3D model with a day surface relief 

constructed from experimental TEM responses 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 Fig. 1.3. Design of a sloping dike with ρ=10 Ohm-m and length L=300 m along the strike 
              (axis Y).  
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   Help window in the XZ Section 
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In this case, the figure has been stretched from -150 m to +150 m along the Y=0 axis in the 
XY plane. The strip appears in the layer h=50-55 m (Fig. 1.4): 

 
                          
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
      
 
Fig. 1.4. The projection of the inclined dike (Fig. 1.3) on the horizontal XY plane 

              (h=50-55 m for the layer). 
  

The parameters Y Length or X Length can be fixed in the box so the program will not ask 
again for this option when drawing a regular structure.  

The painted figures "stretch" along the axis perpendicular to the plane of the plate (XZ or 
YZ) and span the interval [-Y_length +Y_posit, +Y_length +Y_posit] or [-X_length +X_posit, 
+X_length +X_posit], where X_posit and Y_posit is the cut position defined by the triangular 
markers on the XY map. 

The vertical scale can be changed using the Page Up and Page Down keys or using the 
buttons on the bottom left of the window. 

To view the sections in the XY plane, change the position of the triangle depth marker on 
the left side of the map using the ↑↓ arrows. Occasionally, for better viewing, it is expedient to 
hide the grid; you can achieve that using the key combination Alt+G or by pressing the right 
mouse button. 

 
 

  Drawing slips and faults 
 
 

Draw the start (top) and end (bottom) points of the slip on the XZ or YZ section using the 
mouse cursor as shown in Fig. 1.5.  
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                                Fig. 1.5. Drawing slips and faults 
 

Release the mouse button, and the window shown in Fig. 1.6 will request the additional 
parameters. 

 

 
                                         

Fig. 1.6 
 

The sign <+> in the “Slip Shift” window shifts the selected block Up, and < - > shifts it 
Down. After pressing OK, the right side of the slip (fault) is shifted up along the slip; the result 
appears on the screen (Fig. 1.7). 

 

 
 

Fig. 1.7. A horizontally layered section with a fault 
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Drawing layered structures 
 

Draw→Layer opens the window (Fig. 1.8) for drawing layered structures. 
 

 
 

Fig. 1.8. Drawing layered structures 
 

One can change the colour of the layer; choose a colour from the “Resistivity” scale (the 

colours of the markers denote the corresponding position) and click on the colour rectangle in the 

vertical layer scale. 

The style of setting the layers’ parameters according to their thickness or depth can be changed. 

The inclination of the layers is determined by the Slope (%) and Azimuth (deg) parameters.  
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 Drawing prisms and cones. 
 

Draw→Prism or Draw→Cone opens the window for drawing prisms and cones. 
 

 
 

Fig. 1.9. Drawing prisms and cones 
 
The colour of the created figure is determined by the Resistivity rectangle scale (purple in Fig. 
1.9). The quality of the drawn figure depends on the grid’s parameters. When Draw is pressed, 
the figure is superimposed on the existing model in the workspace XYZ. 

For example (Fig. 1.10), a vertical rectangular prism with a resistivity of 5 Ohm-m is 
"inserted" in the section with inclined layers (at the section, the grid is hidden using Alt + G). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

          Fig. 1.10. A prism with ρ=5 Ohm-m in a layered inclined structure. 
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Constructing medium models from experimental data 
 

    2D structures 
 

To construct 2D models of the medium, it is necessary to first create 1D inversion files (int-

files) from the experimental data (tem-files) and either a TEM-RESEARCHER (TemRes) 

program or transformations files (psc). In Tem-Res v. 8 (2008 or later), one can create a *.sec 

file that combines -tem, -psc and -int files (see the description of the TEM/INT/PSC/SEC 

formats in TemRes). 

 In the Section XZ window, it is necessary to open the File→Input Observed Data menu 

and select the file that contains information on the research profile or territory. It can be a PSC, 

SEC or INT file; a map of the location of the sounding points will be shown on the screen (Fig. 

1.11). 

 

               
 
Fig. 1.11. TEM-FAST sounding point location map (*.psc, *.int and *.sec files) 
              

 Activate the Profile switch in the Design section and mark the points on the map that should 
be included in the analysed section (click the left mouse button on the square that denotes the 
TEM-FAST antenna loop). To complete the construction of the profile, double-click any blank 
space on the map; the selected points are coloured red. 

You can also use another method. Using the mouse cursor, draw a broken line that passes as 
close as possible to the desired points on the map (Fig. 1.12A). Each line segment begins and 
ends by pressing the left mouse button. As soon as the last line segment is finished, double-click 
the left mouse button, and the profile is displayed on the map in red, as shown in Fig. 1.12B. 
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Fig. 1.12. Construction of a profile along a broken line 

 
The program automatically "captures" all the measurement within a radius of 10 pixels (!) 

from the drawn broken line (use ZOOM to increase the resolution in the profile construction - 
see the Help window). 

 If all the necessary points are included in the profile, press the Set Model button. If the 
attempt was unsuccessful (which is often the case for complex configurations), you must turn 
the Profile switch off, then turn it on again and make another attempt. 

At a relatively simple location of the sounding points, the program will automatically 
construct the profile, including all the points (Fig. 1.13).  

 

 
 

Fig. 1.13. Automatic construction of the profile after turning the Profile switch on. 
The numbers on the points correspond to the number of the sets in the initial files. By activating 
the Label, Altitude and Name checkboxes, the captions of the sets can be changed.  

 
After successfully constructing the profile and clicking the Set Model button, the window 

Section XZ appears (Fig. 1.14). 
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Fig. 1.14. The section Section XZ with the model based on experimental data 
                            (1D inversion - int files) 
 

When working with an SEC-file that contains transformation data and the results of a 1D 
inversion, one must remember that the section will use the transformation if the menu file dialog 
is set to «Transformation *.psc *sec". If «Inversion * .int * sec" is selected, the model will be 
built according to the 1D inversions. 

If you open a TEM-file or PSC-file that does not contain the 1D inversion data, the program 
will be ready to make the transformation ρ(h) itself and will ask for the parameters for this 
procedure, as shown in the window in Fig. 1.14-1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1.14-1. TEM data transformation parameters (when opening PSC and TEM files)  
                    and a profile built on the transformation ρ(h). 
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These parameters are set like those in the Tem-Researcher program. In addition, there is an 
opportunity to save the TEM smoothed data to a file and use them for further analyses. 

On the right panel in Figure 1.14-1, a 2D section of a 3D model is shown, which was 
constructed from the "raw” TEM (or PSC) data. 

As seen in Figs. 1.14 and 1.14-1 the experimental data are transformed to the discrete model 
grid, and the cell’s size (Grid) and the gradation of the resistivity are defined in the main 
window. If the profile is very long and the number of cells exceeds the permissible limit 
(Nx>300 or Nz>300), the program will automatically resize the cell.  

The relief of the day surface is indicated by the black line, and the air space is demarcated 
by the sky-blue colour. The highest point on the profile is taken as the zero altitude. To obtain data 
on the actual altitude, press Alt + A. 

The resistivity scale Ohm-m or the signal scale V/A is located in the window’s top panel. 
Double clicking the scale caption switches the apparent resistivity scale to the signal level. In the 
upper right corner, the Time window is used to select the delay time t used to construct the E(t)/I 
profile or ρ(t). Negative values of E(t)/I or ρ(t) are bordered by squares. 

The 2D model of the medium that has been constructed can be edited using the previously 
described methods.  

Profile calculations are performed in the Modeling window, and the results are displayed in 
the Profile and Section XZ windows. Thus, we can compare the 3D modelling results with the 
experimental data (Fig. 1.15). 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1.15. The medium model constructed using the experimental data and the profile of 

the experimental (blue curve) and model (red) data in the form of the apparent resistivity ρ(t) 
at time t=1 ms  
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The Section XZ menu contains the following commands: 
 

 
 

Fig. 1.16. Section XZ menu 
 

Input Observed Data – load the experimental data. The possible formats of the data are 
TEM-FAST data (*.tem, *.int,*.sec,*psc) 
Transformation data (*.psc, *sec) 
Inversion data (*.int, *sec) 
Save as int-file (TR format) – save the inversion data in an int-file 
Edit - return one step back or one step forward when drawing a model 
Inversion – open the Inversion window 

    
To compare the experimental and model ρ(t) or E(t)/I responses, click twice on a 

corresponding marker (point) in the upper graph (Fig. 1.17).  
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 1.17. The experimental and model data comparison window 
                           (transient ТЕМ responses vs. time) 
 
 
 
 
 
 

3D model response
(click here to show)

Observed response
(click here to show)

Centers of loops
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Fig. 1.18. The experimental and model transient TEM responses 
 
3D structures 

 
If you have array data in the form of TEM-INT-PSC-SEC files, you can construct a 3D 

model of the medium. After loading the corresponding file, select the Area option in the Design 
section and mark a rectangle to determine the X-Y boundaries of the 3D structure (draw while 
holding the left mouse button down). After clicking the RIGHT mouse button, the data sets are 
painted a red colour, and the Set Model box becomes active (Fig. 1.19). To select all the 
sounding points, press Alt+A. 

 

 
 

Fig. 1.19. Construction of a 3D model using experimental data. Selection of the area. 
 

model

Observed response

Click here to hide /show

Click here to delete
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It is possible to edit a 3D modelling region by activating the Area box and clicking on the 
sounding set point; the change in its colour indicates that the set has joined or been deleted from 
the modelling area.  

After activating Set Model, the program begins to construct the 3D structure; this procedure 
requires some computational time. The interpolation of the resistivity ρ(h) from the INT or PSC 
files conforms to the following rules. 

1. The interpolation is produced over the layers i·dz≥z>(i+1)·dz, (i=0,1,2,…,Nz-1). 
For any (x,y) point with coordinates of the model grid R lying within layer z, the three nearest 
points with coordinates (x1,y1), (x2,y2), and (x3,y3) and resistivities ρ1(x1,y1), ρ2(x2,y2), and 
ρ3(x3,y3) are selected.  
In the 3D space (X, Y, ρ), the plane ρ=A*x+B*y+C passing through the three points ρ1, ρ2, ρ3 is 
determined. The resistivity in the (x,y) cell is calculated according to the foregoing formula when 
the point R(x,y) lies within the triangle defined by (x1,y1), (x2,y2), and (x3,y3). In the cells that 
remain “empty”, the resistivity is calculated according to item 3 as the mean of the nearest 
“filled” cells. 

2. The surface relief is determined according item 3, but in the (X, Y, Z) space. On the 
surface the resistivity of the model is interpolated over the surface relief between the sounding 
points (because all the points have the same altitudes).  

 

 
 

Fig. 1.20. 3D model constructed using array experimental data. 
 

The right panel (XY-plane) corresponds to a horizontal section at a depth of 150 m (triangle 
depth indicator on the left panel). The squares show the location of the sounding antenna. The 
left window, which is labelled Section XZ in the left panel, shows that the TEM data are absent 
because that profile was not chosen. An experimental data profile can be selected by pressing the 
right mouse button on the panel (Fig. 1.21). 
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         Fig. 1.21. Selecting an experimental data profile of a 3D structure 
 

After pressing the mouse button on the Set Model function, the 3D structure rotates around 
the centre of the area so that the selected profile passes through a horizontal axis (the X-axis in 
Fig. 1.22). 

 

 
 

Fig. 1.22. 3D structure and profile of experimental data 
 

Because soundings sets, as a rule, do not lie on straight lines, the profile of the experimental 
data in the Section XZ window is projected onto the horizontal X-axis. The selected profile is 
marked in the XY plane by a black broken line. The profile location indicator (the triangle on the 
vertical Y-axis of the XY window) must be placed close to a selected profile (in our case, Y=-
350 m). Now, the 3D model and X-profile are ready for calculations in the Modeling window 
(Fig. 1.23). 
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                    Fig. 1.23. Profile along the X-axis at Y=-350 m 
 

To select another profile, it is necessary to again click the right mouse button on the upper 
panel of the Section XZ window. 

Occasionally, it is convenient to delete the surface relief from a model (to make a plane 
surface). This procedure is activated by pressing Alt+S. All the possible manipulations of a 3D 
model are described in the Help window. 

3D models can be constructed. Open a data file (Input Observed Data) in the Section XZ 
window, turn on the Area switch and select the area with the data (Fig. 1.23.1A). 

Click the right mouse button and activate the Set Model function, which appears after 
clicking the window shown in Fig. 1.23.1B. Click the right mouse button on the top panel as 
shown in the figure, and open the window to select the profile or area (Fig. 1.23.1C). 

In this window, turn on the Area switch and select the area with data. Clicking the right 
mouse button activates the Set Model function. After pressing the button, the 3D model is 
constructed, and the data from the central profile with the coordinate Y = 0 appear in the upper 
panel of the Section XZ window. By changing the position of the pointer of the latitude 
(Latitude) coordinate of the profile (i.e., changing Y) into the main frame (X-Y plane), one can 
select the desired profile (cross-section) that crosses the created 3D model. 
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Fig. 1.23.1. Construction of a 3D model with the option of changing the Profile position 

of the cross-section (coordinate Y). 
 
 
 
 
 
 
 

A

B

C
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Fig. 1.23.2. 3D resistivity model sections along two profiles with latitudinal coordinates 
Y=0-50 m and Y=450-450 m. The latitudinal position of the profile is controlled by the latitude 
indicator in the main window (right panel, triangular indicator on the Y- axis). The depth of the 
section is controlled by the indicator (left panel, triangular indicator on the Z-axis (z=200 m)). 

 
In the main window (right panel of Fig. 1.23.2), you can save the 3D models of the medium 

layer-by-layer in a text file. Press Alt+S, specify a filename XXX.txt, and the coordinates (X and 
Y) of the model’s cell and the corresponding resistivity log10(ρ) and ρ (Ohm-m) will be saved in 
the file. In addition, the coordinates of the Loop X and Loop Y points are recorded. The altitudes 
of the top and bottom of the horizontal section (layer) model are recorded in the filename, for 
example, XXX_Depth_100-105 m (the depth is specified in the Depth Layer). 

 
 
 
 
 

X(m)  Y(m) log10(Ohm-m) (Ohm-m) Loop X(m)   Loop Y(m)  Loop ALT(m) Name
-2100.0 +1200.0 +2.11461 130.200 +1951.5 -1149.0 -114.0 -08         
-2100.0 +1150.0 +2.26221 182.900 +1853.5 -1091.0 -112.0 -007        
-2100.0 +1100.0 +2.40976 256.900 +1695.5 -1007.0 -109.0 -006        
-2100.0 +1050.0 +2.40976 256.900 +1505.5 -907.0 -107.0 -005        
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Extrapolating the resistivities in the space outside the work zone X×Y×Z 
The modelling grid is irregular and covers a space far beyond the size of model grid 

parameters specified in the main menu. 
 

                                                         
 

Fig. 1.24. Setting the model grid 
 

The rule for extrapolating the resistivity is as follows. Outside a work area covered by cells, 
the resistivity is horizontally layered using the resistivities at the corresponding edges. This rule 
is illustrated in Fig. 1.25. 

 

 
 

Fig. 1.25. Extrapolation of the resistivities outside the work area 
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Fig. 1.26. The 2D-model is complemented outside the border |x|>4000 m by horizontal 
layers with resistivities that correspond to the boundaries of the model grid at |x|=4000 m. 
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Saving the medium models 

Created models can be saved in a file with the extension *.3Dm using (File→Save Model) 
and opened later using (File→Open Model). The File→Open Model operation is used to open 
a *.3Dm file by selecting the required model (by name and size) and loading it into the program. 

 
 

 
      
     The structure of 3Dm - file 

 
<3D MODEL (TEM-3D-WIZARD)  Date: Tue Dec 15 15:12:14 2009 
Name: 3D Model 001 (simple model) 
Reamrk1: demo version 
Remark2: no comment now 
DX (m)=      25.0 
DY (m)=      50.0 
DZ (m)=       5.0 
Nx= 20 
Ny=  4 
Nz= 11 
Codes  Resistivity [Ohm-m] 
0=     500.000 
1=     300.000 
2=     200.000 
3=     100.000 
4=      50.000 
5=      25.000 
6=      10.000 
7=       5.000 
8=       2.500 
9=       1.000 
A=   10000.000 
#   R     G    B  Resistivity Colors 
 1  255    0    0 
 2  255  127    0 
 3  255  255    0 
 4    0  170    0 
 5    0  255  255 
 6    0    0  255 
 7  255    0  255 
 8  127    0    0 
 9  190  190  190 
10  127  127  127 
11  225  253  254 
  Resistivity Maps (X-Y) [20x4 bricks] [500x200 m*m] 
Layer # 1:    0.0-   5.0 m 
55555555555555555555 
55555555555555555555 
55555555555555555555 
55555555555555555555 
Layer # 2:    5.0-  10.0 m 
33333333333333333333 
……………………….. 

  ………………………. 
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Saving and loading the model grids (Grid Setup) 

For this, use File→Save SetUp and File→Input SetUp. 

 
Example of an st p- file: 
 
<<TEM-3D-WIZARD STEUP  Date: Fri Dec 18 12:10:16 2009 
DX (m)=      25.0 
DY (m)=      25.0 
DZ (m)=       5.0 
Nx= 20 
Ny= 20 
Nz= 60 
Codes  Resistivity [Ohm-m] 
0=     500.000 
1=     300.000 
2=     200.000 
3=     100.000 
4=      50.000 
5=      25.000 
6=      10.000 
7=       5.000 
8=       2.500 
9=       1.000 
A=   10000.000 
#     R      G     B  Resistivity Colors 
 1   255     0      0 
 2   255   127    0 
 3   255   255    0 
 4     0     170    0 
 5     0     255  255 
 6     0       0    255 
 7    255    0    255 
 8    127    0      0 
 9    190  190  190 
10   127  127  127 
11   225  253  254 
#   Code   Thickness(m) 
 1    0         20.00 
 2    1         20.00 
 3    2         20.00 
 4    3         20.00 
 5    4         20.00 
 6    5         20.00 
 7    6         20.00 
 8    7         20.00 
 9    8         20.00 
10   9         20.00 
11   10       20.00 
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Part 2. Modelling the TEM responses 
 

 
After constructing the medium model, it is possible to begin modelling the transient 

processes. Activating the Modeling menu opens the window shown in Fig. 2.1.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                               Fig. 2.1. Modelling window 
 
 

In the right part of the window, a section of a 3D model is shown in the XZ plane at Y=0 
together with its extrapolation outside the work zone XYZ (-600 m≥X≥+600 m). The scale of the 
picture can be changed using the (-) (+) (↓) (↑) control elements. 

 H/V=0.18 is the ratio of the horizontal scale to the vertical scale. The horizontal and 
vertical scales are given in meters. 

A 50×50 m2 projection of the coincident transmitter-receiver antenna is shown on the 
surface of the medium at the point X=0 (because parameter X in the Center Loop Position (m) 
section is equal to zero).  

The altitude of the antenna is automatically determined by the surface relief (more precisely, 
according to the base of the sky-blue layer denoted as air). 
The extension of the space grid used for the calculations of the EM field is shown on the section.  
Using the Alt+G combination, the numerical grid can be hidden.  
The grid parameters are specified in the Grid Setting window (Setup button). 
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Fig. 2.2. Grid Setting window for setting the grid parameters used for the calculation  
          of the TEM responses 

 
 The grid step is determined by the Regular grid step Dx=Dy (m) parameter. 
Within the square antenna’s contour, the grid is regular in the x and y directions (dx=dy).  
The size of regular grid area is specified by the Regular Grid Area from “0”(m) parameter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Fig. 2.2A. The grid configuration inside and outside transmitter-receiver antenna (dx=dy) 
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The Increasing kx=ky=(1+delta) parameter sets the coefficient of the grid’s extension 
outside the Regular Grid Area. If xi<xi+1<xi+2 are sequential X-coordinates, then хi+2-хi+1= 
kx*(хi+1-хi). At kx=1, the grid is regular over the entire calculation area. 
The program has the following limitations. 

 L/dx must be an even number (L is the length of the square antenna’s side) and 
 (Regular Grid Area)/dx is an integer number. 
The Max distance from “0” parameter sets the boundaries of the computational grid (by 

default, it is ±3000 m along the X and Y-axes). There are analogous parameters for the Z-axis.  
Increasing kz=(1+delta) specifies the coefficient of the grid’s extension outside of  
Regular Grid Area. 
Max Depth specifies the boundary of the grid along the Z-axis (by default, it is 1500 m). 
Dz near surface fixes the regular step of the grid near the day surface (z=0). 
Regular Grid Area sets the boundary of the regular grid along the Z-axis.    

     (Regular Grid Area)/dz must be an integer number.  
The table of the grid’s nodes is shown in the right part of the window in Fig. 2.2.  

The total number the nodes in the example shown is (37×37×30=41,070).  
The computational time is proportional to the number the nodes. 

 Fig. 2.2В illustrates the numerical grid parameters. 
 

        
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Fig. 2.2В. Parameters of the calculated grid 
 

  
 
 
The accuracy calculation scale of the TEM signals, Accuracy Range, which is conditionally 

divided into 10 levels, appears in the lower part of the window (Fig. 2.2). The calculation time is 
proportional to the Accuracy Range value.  

The Save Grid window is used to save the grid’s parameters in a *.ini file,  
Grid from File is used to set a grid from a *.ini file. 
Three examples are now used to demonstrate the influence of the grid’s parameters on the 

accuracy of the TEM calculations. The two-layer model parameters are ρ1=100 Ohm-m, h=50 m 
and ρ2=1 Ohm-m. 
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Example 1. 
 

The apparent resistivity curves presented in Fig. 2.3 were calculated with the following 
parameters for different values of Accuracy Range: 2, 4 and 6:  

L=50 m,  
dx=dy=3.125 m, 
dz=5 m,  
kx=kz=1.35, 
Regular Grid Area (xy)=25 m, and  
Regular Grid Area z=50 m. 

The black curve corresponds to a 1D layered model calculated using the TEM-RESEARCHER 
program. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Fig. 2.3. Estimation of the influence of the Accuracy Range value on the accuracy of the 
TEM calculations 

 
Increasing the Accuracy Range parameter essentially influences the accuracy of the 

calculations in both the near and far zones of the transmitter (late stage of the transient process). 
 

Example 2 
 

The apparent resistivity curves presented in Fig. 2.4 were calculated using the following 
parameters:  

L=50 m,  
dz=5 m,  
kx=kz=1.35,  
Regular Grid Area (xy)=25 m,  
Regular Grid Area z=50 m, and 
Accuracy Range= 6. 

Ac range=2

Ac range=4

Ac range=6
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The black curve corresponds to a 1D layered model calculated using the TEM-

RESEARCHER program. Only the dx and dy parameters were varied (dx=dy=2.5, 3.125, 6.25 
and 12.5 m). 

 
 

 
 
Fig. 2.4. Estimation of the influence of the dx parameter on the TEM response accuracy 
 

Increasing the dx parameter within 2.5-12.5 m does not significantly affect the accuracy of 
the calculation of the transient responses in the near and far zones of the transmitter. 

 
Example 3 
 

The apparent resistivity curves shown in Fig. 2.5 were calculated using the following model 
parameters: 
 

L=50 m,  
dx=dy=6.25 m,  
kx=kz=1.35,  
Regular Grid Area (xy)=25 m,  
Regular Grid Area z=50 m, and 
Accuracy Range= 6. 
 

The black curve corresponds to a 1D layered model calculated using the TEM-
RESEARCHER program. Only the dz parameter was varied (dz=2.5, 5 and 10 m). 
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Fig. 2.5. Estimation of the influence of the dz parameter on the TEM response accuracy 
 

Increasing dz from 2.5-5 m had no effect on the accuracy of the calculation of the transient 
processes; however, at dz≥10 m (blue curve), a 15% distortion occurred in the intermediate zone 
of the transient. There were no distortions in the early (t<10 µs) and late stages of the transient 
process (t>500 µs).  

It should be noted that even essential changes in the kx, kz, Max distance from “0” and 
Max depth parameters essentially had no effect on the accuracy of the calculations. 

 
A model of a medium and a computational grid 
 

As previously defined, the grid used to construct the models is regular along the X-, Y-, and 
Z-axes, whereas the grid used to calculate the TEM responses logarithmically expands in space. 
It is therefore impossible to accurately match the boundary lines of the model blocks and 
computational grid everywhere. 

For example, if a medium is horizontally layered, to obtain accurate calculations, it is 
necessary to match the nodes of the computation grid along the Z-axis with the layer boundaries. 
However, this matching is possible only by concentrating the grid nodes along the vertical axis. 
When the z-nodes do not match the grid boundaries, the TEM signal calculations are somewhat 
inaccurate because the model used for the calculations differs from the initial model (Fig. 2.6). 
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Fig. 2.6. The grid and horizontally layered medium boundaries 
 

Within the limits of the nodes of grid z2>z>z3 (L3) and z3>z>z4 (L4), the resistivity does not 
coincide with the resistivities of the first, second and third layers. The resistivities in such border 
layers are calculated using a special algorithm that accounts for the resistivity of the cell model 
in three orthogonal directions (the cell model is considered to be anisotropic with respect to the 
resistivity ρx, ρy, and ρz). Evidently, a universal algorithm that can provide a precise calculation 
of the fields for an arbitrary model does not exist. Inaccuracies will always result from the 
“substitution” of an initial model of the medium using a calculation model corresponding to the 
given parameters of the grid. The resulting errors decrease as the nodes (and lines) of a 
calculation grid approach the contrast boundaries of a model. 

As a rule, superficial horizontal model boundaries can be easily combined with the 
computation grid lines by fitting dz and the Regular Grid Area z parameters, and deep lying 
boundaries (not all, but the most important) can be combined by manipulating the kz coefficient. 
The vertical boundaries along the X- and Y-axes can be treated in a similar way. 

There is no universal method for constructing the grid for any medium’s model. However, a 
user can independently find an acceptable solution to this problem in the process of working with 
this program. 

The next example demonstrates the fact that even in a rather complicated situation close to 
the real one, the value of the Regular Grid Area parameter (over the depth z) insignificantly 
affects the modelling results.  

Fig. 2.6А depicts the results of the calculations for a medium model that contains an inclined 
high conductivity dike. The calculations were fulfilled for the grid with two different parameters 
(at depth): Regular Grid Area=150 m and 50 m. When the Regular Grid Area equals 150 m, 
all the vertical boundaries of the inclined dike coincide exactly with the boundaries of the grid, 
whereas when the Regular Grid Area equals 50 m, none of them coincide with the 
computational grid. Nevertheless, the results of the calculations practically coincide (the 
difference is less than 2%). 
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Fig. 2.6А. The profile crossing the inclined dike: the calculations. The red curve corresponds 
to calculations with the following parameters: dz=5 m, Regular Grid Area (z)=150 m, (~90,000 
cells, and the calculation time is ~4 s); blue curve dz=5 m, Regular Grid Area (z)=50 m, 
(~50,000 cells, and the calculation time is approximately 2 s). 

 
Fig. 2.6B presents the TEM responses at point x=0 for the profile shown in Fig. 2.6A. The 

calculations were made with two different grids, the parameters of which are presented in the 
lower panel of Fig. 2.6B. 
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Fig. 2.6В. TEM responses in the normalization of the apparent resistivity, corresponding to the 
point x=0 in the profile (see Fig. 2.6A). The bottom panel shows the parameters of the 
calculated grids for the red and blue ρ(t) curves. 
 
Although the computational grid corresponding to the blue curve is ~3 times less dense than 

that for the red curve, the difference is less than 3.5% in the middle stage of the TEM process.  
Let us return to the main modelling window. 

 
 
 



 39 

                      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 2.7. Modelling window 
 

Name – set name that should be written in the TEM file 
Browse - Save as - name of the TEM file for the saved results of the calculations 
Side ≥ 1 - length of the side of a square coincident antenna (loop) in meters 
Depth ≥ 0 - depth of the antenna (counted from z=0) in meters 
Max time (ms) - maximum time of the TEM response (1/4 – 16 ms)  
Setup - activate the window for setting the calculation grid parameters 
Response vs. time - activate the window for the ρ(t) or E(t)/I graphs  
Profile - activate the window of the model medium and the graphs of ρ(t) or E(t)/I along 
               a profile. 
The window becomes active after the calculation or loading of profile data (Import). 
Center Loop Position (m) - set the antenna position 
Run - start the TEM response calculation for a given position of the antenna (XY) 
Design X-Profile (m) - section for setting the parameters for the profile calculations 
Step – step along the profile (meters), Step>0  
Min – initial position of the antenna centre on the profile (meters) 
Max - final position of the antenna centre on the profile (meters) (Max>Min) 
Start - start the profile calculations. The set’s names correspond to the antenna location on 

the X-axis. The profile data are saved in two text files that have the same name but have *.tem 
and *_3DPR.txt extensions as specified in the Save as window. The model parameters are 
written in the last file. 

Import - function for loading the profile data and previously calculated model saved earlier 
in *3DPR.txt and *.tem files. After loading, the model can be recalculated using other grid 
parameters, or the model can be changed. 
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Data Type in menu Import: 
 

 
 

- Profile 3D - enter the profile data (txt-file) and configure the appropriate model (the 
previously loaded model will be replaced!) – Fig. 2.7A. 

- TEM-FAST file - enter the TEM data (observed or calculated) 
- INT/PSC/SEC - enter the TEM input data format (-int, -psc, -sec) 
- Multi-Profile picture - enter the data in the -tem, -int, -psc, and -sec formats to build 

multiple profile pictures (6 profiles on the same panel from 6 different TEM files) - Fig. 2.7A. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 2.7A. Window Profile.  An example of a multiple profile picture (responses at a 

fixed time t=1 ms from 6 different TEM files). The medium models differ by the thicknesses 
of their upper layers (ρ=20 Ohm-m). 
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Format the text file *.3DPR.txt that contains the profile data: 
 

<ADVANCED 3D MODELING NT= 24
<NSET= 11
Voltage  [V/Amp]  Loop=  25.0x 25.0 m*m Rec= 25.00x25.00 m*m turn=   1.000
  #     LAT(m)   LONG(m)   time (us) time (us) time (us) time (us) time (us) time (us)
                          4.05612 5.0659 6.06912 7.07705 8.5172 10.529

1 -500 0 1.58E-01 9.41E-02 6.14E-02 4.25E-02 2.72E-02 1.63E-02
2 -400 0 1.58E-01 9.41E-02 6.14E-02 4.25E-02 2.72E-02 1.63E-02
3 -300 0 1.58E-01 9.37E-02 6.08E-02 4.19E-02 2.66E-02 1.57E-02
4 -200 0 1.44E-01 8.07E-02 5.00E-02 3.36E-02 2.14E-02 1.36E-02
5 -100 0 1.44E-01 8.06E-02 4.99E-02 3.34E-02 2.12E-02 1.33E-02
6 0 0 1.44E-01 8.06E-02 4.99E-02 3.34E-02 2.12E-02 1.33E-02
7 100 0 1.44E-01 8.06E-02 4.99E-02 3.34E-02 2.12E-02 1.33E-02
8 200 0 1.44E-01 8.06E-02 4.99E-02 3.34E-02 2.12E-02 1.33E-02
9 300 0 1.44E-01 8.06E-02 4.99E-02 3.34E-02 2.12E-02 1.33E-02

10 400 0 1.44E-01 8.07E-02 5.00E-02 3.36E-02 2.14E-02 1.36E-02
11 500 0 1.58E-01 9.37E-02 6.08E-02 4.19E-02 2.66E-02 1.57E-02

Apparent Resistivity [Ohm-m]
1 -500 0 111.94 109.25 107.51 106.27 105.03 103.88
2 -400 0 111.94 109.25 107.51 106.28 105.03 103.89
3 -300 0 112.04 109.56 108.15 107.35 106.77 106.43
4 -200 0 119.04 121.05 123.25 124.39 123.32 117.37
5 -100 0 119.06 121.14 123.47 124.86 124.27 118.99
6 0 0 119.06 121.14 123.47 124.86 124.27 119
7 100 0 119.06 121.14 123.47 124.86 124.27 119
8 200 0 119.06 121.14 123.47 124.86 124.27 119
9 300 0 119.06 121.14 123.47 124.86 124.27 118.99

10 400 0 119.04 121.05 123.25 124.39 123.32 117.37
11 500 0 112.04 109.56 108.15 107.35 106.77 106.43

****************************** ADVANCED 3D-MODEL *****************************************************************************
  Ohm-m
0 -     1000.000
1 -      500.000
2 -      250.000
3 -      100.000
4 -       50.000
5 -       25.000
6 -       10.000
7 -        5.000
8 -        2.500
9 -        1.000
A -    10000.000
Nx= 40 Dx=    50.000
Nz= 60 Dz=     5.000
Ny= 40 Dy=    50.000
<<*****************************  COMPLETE 3D MODEL ***********************************
  Resistivity Maps (X-Y) [40x40 bricks] [2000x2000 m*m]
Layer # 1:    0.0-   5.0 m  

55555555555555555555555555555555555555555555555555 
55555555555555555555555555555555555555555555555555 
33333555555555533333333333333333333555555555555555 
33333333333333333333333333333333333333333333333333 
33333333333333333333333333333333333333333333333333 
11111111111111111111111117774444444444444444444444 
11111111111111111111111117744444444444444444444444 
11111111111111111111111177744444444444444444444444 
11111111111111111111111177744444444444444444444444 
11111111111111111111111177444444444444444444444444 
11111111111111111111111777444444444444444444444444 
11111111111111111111111777444444444444444444444444 
11111111111111111111111774444444444444444444444444 
11111111111111111111117774444444444444444444444444 
11111111111111111111117774444444444444444444444444 
11111111111111111111117744444444444444444444444444 
11111111111111111111117744444444444444444444444444 
11111111111111111111177444444444444444444444444444 
11111111111111111111177444444444444444444444444444 
11111111111111111111177444444444444444444444444444 
11111111111111111111774444444444444444444444444444 
11111111111111111111774444444444444444444444444444 
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*.ini format of the computation grid’s configuration file  
 
NAME:  TEM_01 
Regular Step Dx=Dy= 6.250 
kx=ky=1.350 
Max distance (X,Y)= 5000.000 
Area XY with regular grid= 25.000 
kz=1.350 
Regular Step Dz=5.000 
Loop= 50.000 
Depth of loop= 0.000 
Max Depth=1500.000 
Area Z with regular grid=20.000 
 
TEM Response window 

 

 
   
Fig. 2.8. Apparent resistivity curves ρ(t) corresponding to different locations of the 

antenna along the profile. 
 

Control functions: 
Res(t) - depict the TEM response as the apparent resistivity ρ(t) 
E(t)/I - depict the TEM response as the voltages on the antenna’s terminals 
Abs - the absolute values of |ρ(t)| or |E(t)/I| 
Err - depict the confidence intervals for the experimental TEM responses 
Info - brief information on the experimental TEM responses 
Grid - set the details of the logarithmic grid 
Line - connect the experimental TEM responses with lines and dots 
Symbol - denote the dots on the model TEM responses using square boxes  

The labels 50.0, 150.0, and 350.0 corresponding to the first three of the last six calculation sets 
(responses) are highlighted in the lower left corner. Double clicking the mouse button removes 
the corresponding graphs from the screen.  
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Menu: 
File→Input Field Set - activate the loading sets of experimental data from a TEM file 

(including the binary files from a Nomad (handheld) computer) 
 

 
 
Fig. 2.9. The window for loading experimental data. The four selected sets are ready to be 

loaded. 

 
Use “current cut-off Delay” - activate the automatic correction of the experimental TEM 

responses, taking into account the real switch-off ramp of the electric current in the antenna     
                                   
       ATTENTION: 
When using model data, the Use “current cut-off Delay” function must be “Off”. 
 
XYZ - view the coordinates of the data sets 
Sort - sort the data according to different criteria 
Unselect - cancel the current set selection  
OK - load the selected data sets (≤ 6) 
If the data stack (the window in left low corner) is occupied by already loaded data, double 

clicking on an unnecessary set removes it. 
Thus, you can simultaneously process 6 models and 6 experimental TEM responses (Fig. 2.10). 

Double click on the model set name result in deleting of this set. 
 

Thus, using the TEM Response window (Fig. 2.8), one can set 6 models and 6 experimental 
TEM responses simultaneously. 
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Fig. 2.10.  TEM Response window. The names of the model sets are in the lower left corner, 

and information on the experimental sets is in the Field Sets window. 
   

Double click on the name of the model set to delete the set.  
Double click on the name of the experimental set in the Field Sets window to delete the 

set.  
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          Profile window 
 

 
 

Fig. 2.11. The medium model and the results of the calculations of the apparent resistivity 
ρ(t) along the profile at a time delay t=1 ms. 

 
The possible manipulations in the “?” window are listed in Fig. 2.12. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
                     

Fig. 2.12. List of commands in the “?” window 
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 Double clicking any graph point makes a copy of the TEM response in the TEM Response 
window. 

Double clicking the left vertical axis (on the V/A or Ohm-m names) changes the Resistivity 
↔ Voltage regimes.                                        

The (-) (+) (→) (←) (↓) (↑) control elements can be used to change the scale of the picture. 
Press Alt+T to delete all the control elements from the map (Fig. 2.13). 

 

 
    
 

Fig. 2.13. The Profile window after pressing Alt+T. This window is convenient for 
cropping and inserting files and presentations into a text. 

 
The Modelling window in the Design X-Profile section allows profile model data 

(*3DPR.txt) and experimental data from TEM, PSC, INT or SEC (Fig. 2.14) files to be loaded. 
 

 
 

Fig. 2.14 
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Fig. 2.15. Model of the medium and corresponding experimental (blue) and model (red) 

curves of E(t)/I, t=1 ms 
 

Occasionally, 3D modelling is carried out to evaluate the TEM-FAST resolution under 
different geological conditions. In that case, the calculated TEM responses for models with 
identical geometries and different resistivities are of interest; for example, for the investigation 
of an anomalous target of different resistivity embedded in a layered section. 
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A 3D model of a kimberlite intrusion constructed by transforming experimental data is 
shown in Fig. 2.16. 

 

 
 

Fig. 2.16. The model of a kimberlite intrusion with TEM responses that correspond to 
two variants of the kimberlite body’s resistivity: ρ=10 Ohm-m (red) and ρ=3 Ohm-m (blue). 

  
The red curve and model were constructed using the 3D-model file loaded from PIPE_10 

Ohm-m_3DPR.txt, and the blue curve was constructed after loading the TEM file PIPE_3 Ohm-
m.tem. 
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Fig. 2.17 shows the field measurement data together with the 3D modelling results along a 
profile that crosses the kimberlite pipe. The pipe model is the same as that in Fig. 2.16. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 2.17. The model of the kimberlite intrusion and graphs of the TEM responses: red - 

3D model for the kimberlite resistivity ρ=3 Ohm-m, blue - experimental data 
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Part 3: Inversion of the observed data 
 
The Inversion window can be activated in the Section XZ menu (Fig. 3.1). 

 
Once the user has downloaded the experimental data measured along the profile or the area 

and the program builds a 2D or 3D model of the medium, the Inversion Setting window (Fig. 
3.1) in Section XZ becomes available. 

 

 
 

Fig. 3.1. The Inversion Setting window in Section XZ 
 

The 3D Modelling SetUp section completely duplicates the Setup section of the Modelling 
window. It sets the grid parameters for the calculation of the 3D model. 

The Make 1D Profile button activates the pointwise calculation of the TEM responses of 
the 1D models constructed for each profile point; at each point of the profile where there are 
observed data, a fragment of the 3D model is replaced by the 1D layered model, and the 
responses are calculated (the number of layers and their thicknesses are determined by the model 
grid parameter dz). 

The Make 3D Profile button activates the calculation of the TEM responses of the 3D 
models for all the “active” points of the profile. The active points are denoted by triangles on the 
horizontal axis of the Section XZ panel (the deactivation/activation of a set is fulfilled by a 
double click on the triangle, and a global deactivation/activation by pressing Alt+@). 
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 The 1D Point Inversion button begins the 1D pointwise inversion of the observed data for 
all the points on the profile. The result of the inversion at each point of the profile does not 
depend on the results of inversion on the adjacent points. The initial resistivity values as well as 
their maximum and minimum values can be specified in the Resistivity Ohm-m section. In the 
case of a 1D inversion, fixing the resistivity (Fix switches) is not valid. 

Because the inversion at each point of the profile is carried out with respect to the resistivity 
of the multilayer 1D model (up to 30 layers with fixed thicknesses h=dz, which is determined in 
the Grid Range main menu), in some cases thin layers with high resistivities and small 
conductances S=h/ρ (power/resistivity) can appear. These layers do not contribute to the 
calculated response but significantly distort the model of the medium. To eliminate such layers, 
the option Delete small S=h/Res blocks is applied. 

 Figure 3.2 shows the inversion results for two identical models of the medium that were built 
from the same observational data. Both models have been artificially "distorted" by introducing 
several thin layers with h=5 m and resistivity ρ=1000 Ohm-m (S=0.005 Ohm-1). The left panel 
shows the results of the 1D Point Inversion with the Delete small S=h/Res blocks option 
deactivated, and the right panel shows the results with the option activated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.2. Inversion results with the Delete small S=h/Res blocks option enabled and disabled. 
 

If the source data are complicated by Induced Polarization (IP) effects, the average, 
maximum and minimum values of the polarizability can be set in the Polarization Model of 
Surface rock section. The polarization effect is calculated only for the first surface layer. 

The Global 1D Inversion button activates a 1D pointwise inversion of the observed data for 
all points on the profile simultaneously. The program selects the combination of the resistivity 
that minimizes the discrepancy between the experimental and calculated data across a given 
array of TEM responses. 

  
The 3D Inversion button starts the 3D inversion of the measured data for all the active 

points on the profile (shaded triangles in Fig. 3.2.1). 

Delete small S=h/Res blocks =ONDelete small S=h/Res blocks =OFF
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Fig. 3.2.1. The fragment of Section XZ window with location of the sounding antennas 
         centres 

 
 

Before starting this function, you must specify the mean (Mean), minimum (Minimum) and 
maximum (Maximum) resistivities. The Fix column is necessary to fix the resistivity so that it 
will not change during the data inversion (Resistivity Ohm-m section). 

The procedure of a full 3D inversion with respect to a set of 10 resistivities can be extremely 
time consuming and does not always lead to acceptable final results because the inversion is 
performed with respect to blocks of resistivity whose boundaries are not changed during the 
inversion. Therefore, in the preliminary stage, we recommend using pointwise 1D inversions and 
several preliminary calculations of the 3D responses (Make 3D Profile) and “manually" 
choosing (drawing) an acceptable geometry of the model’s blocks. 

When starting the Make 3D Profile and 3D Inversion procedures, it is necessary to specify 
the file name where the results of the calculations will be recorded. For example, after you set a 
file named XXX and after the calculation, the files will have the following names: 

XXX_INV_ (15-27).ini - file with the estimated parameters of the grid, 
XXX_INV_ (15-27).3DPR.txt - file with the relevant TEM data, 
XXX_INV_ (15-27).3Dm - file with the data model of the environment, and 
XXX_INV_ (15-27).tem - file with the TEM data for all the points of the profile will arise. 
The creation time (hours-minutes) of the files is indicated in parentheses. 

Fig. 3.3 shows the results of the preliminary data inversion. The preliminary model is based on 
“raw” TEM data that have been transformed into psc-data on loading (left panel). The model is 
clarified on the basis of the 1D pointwise inversion. 

Active set Inactive set
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Fig. 3.3. Smoothing and transformation parameters in the left pane and the observed data 
(blue) and model (brown) in the right pane.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 3.4 The observed data (blue) and TEM responses (red), calculated (function  
Make 3D Profile) for the 3D model based on the 1D inversion data (Fig. 3.3). 
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Fig. 3.4 shows that in the area of the points with coordinates x=400-500 m, it is necessary to 
correct the model because there is significant difference between the observed and calculated 
responses at later times. 

Using the results of a "manual" correction of the model, the TEM responses (normalized 
apparent resistivities) at time t=1 ms are shown in Fig. 3.5. The discrepancy between the 
observed and model responses (rms) is ~24%. If you need more detail in the "drawing" model, 
you can continue the correction. However, in this example, the anomaly associated with the 
kimberlite pipe (x=450-550 m) was interpreted in sufficient detail and does not require further 
correction. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 3.5. The observed and calculated 3D TEM responses expressed as the apparent 

resistivity at time t=1 ms. The local anomaly corresponds to a kimberlite pipe with a 
resistivity ~ 3.8 Ohm-m and a horizontal section of ~100×100 m2. 
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Inversion of the profile data in the "manual mode" 
 
After loading the TEM profile data (INT-data, from the 1D TEM-RESEARCHER inversion 
program), the geoelectric section is shown in the Section XZ window, as seen in Fig. 3.6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.6. 2D geoelectric section constructed on the base of 1D inversions 
 

The key combination ALT+D displays the ranges of the depths corresponding to the 
selected time (where t=100 μs) using black lines. On the distance axis, the centres of the 
sounding antennas are denoted by triangles. The sounding points can be deactivated and 
activated by double clicking the left mouse button on the corresponding triangle. In this example, 
the observed data at these points did not disappear; however, during the calculation of the model 
responses, the "inactive" points are ignored, which significantly saves calculation time. 

When working in "manual mode", it is convenient to use a second screen (2-d Screen 
button), as shown in Fig. 3.7.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig. 3.7. Additional 2-d Screen, opened in the Section XZ window. 
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Whenever the 3D profile calculations are performed, the TEM-responses corresponding to 
the selected medium model are mapped on an additional screen. In the upper right corner, the 
discrepancies between the model and the observed responses (rms %) for the selected time 
(where t=1000 μs) are shown. Thus, using the "designing" geoelectric section (by introducing 
new blocks or editing existing blocks) in Section XZ on the second screen, one can control the 
changes in the model responses ("history" does not contain more than 6 responses).  

The researcher can return to the best (from his point of view) model variant using the 
menu’s Edit->Undo/Redo function. 

Occasionally, in a small section of a long profile, the discrepancy between the experimental 
and model data is unacceptable (for example, Fig. 3.8). 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.8 Profile of TEM responses at time t=100 µs with a selected area of active 
soundings sets. 

 
To correct the geoelectric section in the selected area, you must activate all the profile points 

(ALT+@) and then double-click the mouse to activate the desired sets. You can then edit the 
resistivity section in the selected interval and check the results of the model design by starting 
3D Profile from 2-d Screen (Fig. 3.9). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 3.9. Results of the TEM response calculation in the highlighted range of the profile 

shown in Fig. 3.8.   
             
 

Active sets
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The 13 steps of a 3D inversion  
 
Based on our experience with 3D inversions of experimental data, we propose the following 

stages (steps) of interpretation. 
 

1. Using the TEM-RESEARCHER (TemRes) filter, eliminate soundings sets that are 
distorted by noise, induced polarization effects (IP) or superparamagnetic effect (SPM).  

2. Run a 1D inversion on the filtered area or profile data in TemRes. At this stage, you have 
to set geologically reasonable limits for changes in the layers’ resistivities and thicknesses. All 
the area or profile data with the edited X-Y-Z coordinates must be in the same sec or int-file. 

3. In the main window, set the size of the model grid (Grid) along the Z-axis based on the 
characteristics of the geological problem to be solved (approximately dz~L/20, where L is the 
size of the antennas). The sizes of the cells in the X and Y directions (dx=dy) and the size of the 
model (Range) are automatically determined when the data are loaded. 

4. Load the int-file (the window Section XZ, File->Input Observed data type of files when 
loading - Inversion data) Fig. 3.10A, switch on Design Profile and mark the needed profile. 
Click the right mouse button on any point on the tablet; the marked area is coloured red (Fig. 
3.10B). Press the Set Model button, and the 2D model of the medium is ready (Fig. 3.10C). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.10. The sequence for constructing a 2D model: int-input data (A), marking all (or 
part) of the profile (B), construction of the 2D models, taking into account the earth's surface 
relief (C). 

 
5. If there are area data, and you want to build a 3D model, you must perform the following 

actions: enter the data in the int-or sec-file (Fig. 3.11A), turn the Design Area switch on, mark 
the area (check box with the left mouse button) and click the right button in an arbitrary place on 
the tablet; the selection area will then be marked in red (Fig. 3.11B). Click the Set Model button 
and build a 3D model without marking profiles (Fig. 3.11C). Next, right click on the top bar of 
the window (Fig. 3.11C) and remark the area (or profile). This results in a 3D model and 
highlights the central area of the profile (y=0) (Fig. 3.12.). Now, run the 1D inversion process for 
the entire built model (Alt+W). 

 
 
 
 

A B C
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Fig. 3.11. The sequence of building a 3D model: int-data input (A), mark all (or part of) the 
area (B), build the 3D model, taking into account the relief of the earth's surface without marking 
the profile (C). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.12. The results of constructing the 3D model. The isolated central part of the profile 
for (y=0). By moving the mouse pointer in the latitudinal direction «Change Y», you can select 
the desired profile, and the TEM data will appear in the Section XZ window. 

 
 

A B

C

“Change Y”
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If you want to draw a profile in any direction, then, at the step shown in Fig. 11c, activate the 
Design Profile switch and mark the desired sets (Fig. 3.13). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.13 Marking the profile in an arbitrary direction. 
 

After clicking Set Model, a model that is expanded such that the selected profile is similar in  
The X-axis direction is displayed (Fig. 3.14). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 3.14. 3D model that is unfolded to an arbitrary angle, based on TEM areal data.  
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6. Set the necessary inversion parameters in the Section XZ->Inversion window 
 (1D and 3D) and leave this window using the Set Up (button) command.  

7. Activate an additional screen using 2d Screen in the Section XZ window. 
8. Start the 1D Invers process. The model responses are drawn on the top panel in a brown 

colour. 
9. Start the 1D G Inv (global 1D inversion) process to optimize the scale of the resistivities. 

In this process, the colour palette of the section does not change; only the resistivities that 
correspond to each scale colour change. After the inversions, if the value of the residual does not 
exceed 10-15% for all the TEM response times, this procedure has only slightly corrected the 
resistivity levels. 

10. Set the optimum (in terms of the geological problem to be solved) grid parameters and 
calculation level of accuracy (Accuracy Range). To do that, open the Modelling window and 
then the Setup window. On the Modelling panel, you can see how the calculated net "covers" 
the analysed model of the medium. 

11. Start the 3D Profile procedure, which will produce results like those shown in Fig. 3.15. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.15. TEM responses calculated using the 3D Profile procedure for a profile crossing the 
3D model. Blue - observed data, red - 3D model responses for three different times: t=25 µs, 250 
µs and 2 ms. 
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For each point on the profile, you can estimate the degree of closeness of the model and 
observed responses. For that, double-click the left mouse button on any blue and red symbol 
on the graphs (Fig. 3.15) to open the Response vs. time window (Fig. 3.16). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.16. Apparent resistivity curves of the observed (triangles) and model responses (solid 
line) for the point on the profile labelled “33393”. The label -50.0 is the name of the model 
response. 

 
12. A user can edit the medium model interactively. The possible actions are described 

above in the “Inversion of profile data in the manual mode” section. 
13. After editing the model by pointwise fitting the experimental and model responses, limit 

and fix the model resistivities as needed and run the 3D Inversion procedure. Keep in mind that 
that the time required to perform a 3D inversion is proportional to the product of the number of 
points on the profile (or array) and the number of unfixed resistivities. 

During operation, the program saves intermediate results in the following files:  
*.3Dm – file containing information on the 3D model, 
*.ini - file containing the estimated grid parameters, 
*.int - file containing the 1D inversion data, 
*.tem - Standard TEM file with the model responses, and  
*3DPR.txt - file containing the responses for the 3D profile. 
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 Notice 

  
The ability to competently perform three-dimensional data inversions of TEM 

soundings is the apex of an interpreter’s professionalism. The proposed program provides a 
great opportunity; for the novice, do not be confused by the difficulty required to master this 
program - the loss of time spent in training will pay off handsomely during its application. 

Forward - and good luck to you! 


